
Incident Time System User’s Guide
The Incident Time System (ITS) is part of the I-Suite group of software 
programs. ITS allows you to collect and track incident time for Federal, 
Casual (AD), and other personnel, and for Emergency Contracted Resourses. 
ITS allows you to create pay documents, the Fire Time Report (OF-288) and 
the Equipment Use Invoice (OF-286). By collecting accurate time data, you 
can generate meaningful management reports.

Topics in this guide include the following:

• About this guide
• Getting Started
• Working with incident information
• Working with personnel information
• Working with crews and members/operators
• Working with contractor and agreement data
• Working with commissary debits and additions
• Working with reports
• Performing searches for personnel or equipment
• Putting it all together.
For information about installing ITS, please refer to the “I-Suite 
Administrator’s Guide,” which is available for download on  
http://isuite.nwcg.gov.

About this guide
This Incident Time System User’s Guide is organized into sections, based on 
the types of tasks you will commonly perform. At the beginning of each 
section you will find an overview of the topics explained. Where appropriate, 
diagrams are shown immediately following each task. Topics in this section 
include:

• Before you begin
• Conventions.

Before you begin
Before using ITS, you must be feel confident that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with Windows 2000, Windows XP, or Windows NT and 
can log on and log off.
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Conventions
The following conventions are used within this guide:

• Button names, option labels, screen names, tab names, and text box 
names appear in bold, in the same case as on your keyboard or screen. For 
example, the fist step in a procedure might instruct you to

1 On the Incident Data menu, click the Incident # drop-down arrow, 
and then click to select the Incident of your choice. 

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text. The text appears in italic type. 
For example, the following note appears in the “Working with incident 
information” section

While working in the Manage All Incidents as One mode, you must 
select an incident for posting each resource’s time.

Getting Started
This section explains the basic concepts and information you need to begin 
using ITS. Topics in this section include:

• Terms and concepts
• Security
• Logging on and logging off
• Getting help
• Understanding the stand-alone and integrated environments.

Terms and concepts
This section outlines some of the screens, toolbars, and menus that you will be 
using in ITS. If you aren’t already familiar with ITS or have forgotten a few 
things since training, review these terms and concepts before proceeding with 
the remaining sections in this guide.

The following diagram shows the ITS toolbar and a brief explanation of the 
toolbar buttons.
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The following diagram shows the top portion of the ITS application and a 
brief explanation of the screen elements and terminology used throughout this 
guide.

Security
Be prudent when working with private information such as Social Security 
Numbers (SSNs) and IRS Federal Employer Tax ID Numbers (EINs).This 
information is to be kept confidential.

Your CTSP manages the ITS password, who can change it using the 
AdminTool that is shipped with the I-Suite software. Only under special 
circumstances, such as operating in a stand-alone environment, would you 
ever need to change your ITS password.

For more information about clearing out SSNs and EINs, see “Clearing out 
Social Security Numbers,” in the “I-Suite Administrator’s Guide. For more 
information about changing the ITS password, see “Managing security” in the 
“I-Suite Administrator’s Guide,” or contact your CTSP.
September 9, 2004 3



Incident Time System User’s Guide Incident Time System User’s Guide
Logging on and logging off
This section explains how to log on and log off of ITS. 

To log on to ITS
1 From your Desktop, double-click the ITS icon or click Programs from 

the Start menu, point to I-Suite, and then click ITS.

If you have trouble logging on to ITS, please refer to the “Handling installation 
problems,” in the “I-Suite Administrator’s Guide,” which is available for 
download on http://isuite@nwcg.gov.

To log off ITS
• On the ITS menubar, click Exit ITS, or click Exit on the File menu.

Getting help
This section explains how to access and locate help information. There are 
three basic ways to obtain help information for ITS:

• Access the I-Suite website. This site contains a wide array of I-Suite 
information, including software downloads, updates, and user 
documentation.

• Contact the I-Suite Helpdesk. If you are unable to answer your question 
using the I-Suite website, contact the I-Suite Helpdesk at (866) 224-7677.

• Review this Incident Time System User’s Guide. This guide is 
available in Acrobat format. To locate topics of interest, click to select the 
Bookmark of your choice. Bookmarks are listed along the left-hand side 
of the Acrobat document. When you click the Bookmark, you will 
advance to that topic within the document.

To display help information within ITS
• On the ITS menu bar, click Help, and then click Support.
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The following diagram shows the ISuite Support dialog box. 

To locate help information on the I-Suite website
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the ITS application icon.

4 On the ITS webpage, click to select the topic of your choice.

The following diagram shows the ITS application icon on the Welcome to  
I-Suite webpage.
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The following diagram shows the ITS webpage and a list of available topics.

To contact the I-Suite Helpdesk

The I-Suite Helpdesk is available 24-hours per day, seven days per week.

• Call (866) 224-7677, or email helpdesk@dms.nwcg.gov.

To obtain a copy of this Incident Time System User’s Guide
1 Start your Internet browser.

2 In the Address box, type http://isuite.nwcg.gov, and then press ENTER.

3 On the Welcome to I-Suite webpage, click the ITS application icon.

4 On the ITS webpage, click to select ITS User’s Guide.

5 In Acrobat Reader, save the file to your personal computer in a folder 
location of your choice.
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Understanding the stand-alone and integrated environments
This section explains the difference between working in the stand-alone 
environment or the integrated environment. While you may only be using ITS 
for your work, it is important to understand how the information you enter in 
ITS affects other I-Suite programs in the integrated environment. 

Typically, you will be working in the integrated environment.

• Integrated environment. Data ownership is shared between the 
Resource Planning and Finance groups. Resources, crews, and operators 
are already entered in IRSS. Maintaining data standards is critical.

• Stand-alone environment. All data is entered and managed by ITS users 
for timekeeping and making payments.

Since data is shared between IRSS, ICARS, and ITS, any changes you make 
within ITS affects the data within ICARS and IRSS.

Remember, what works for one incident may not work well for another!

Working with incident information
This section explains how to enter and edit incident information. Topics in 
this section include:

• Managing incident data
• Managing accounting codes.

Managing incident data
This section explains how to review, edit, and add incident data and how to 
list all resources together and manage all incidents as one.

To review and edit incident data
1 On the Incident Data menu, click Incident Add/Edit.

2 Click the Incident # drop-down arrow, click to select the Incident of 
your choice, and then click the Edit tab.

3 Modify the following information as appropriate

- Incident Name
- Incident Number
- Accounting Code
- Location
- State
- Start Date.

4 To save your changes, click the Save button.
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The following diagram shows the Edit tab on the Incident Add/Edit screen.

To create a new incident

Be sure to follow the appropriate data standards!

1 On the Incident Data menu, click Incident Add/Edit.

2 Click the Add tab.

3 In the Incident Name box, type the Incident Name.

4 In the Incident Number box, type the Incident Number, in the format 
[HOST ID] - 99999.

5 In the Accounting Code box, type the Accounting Code number.

6 In the Location box, type the Location name.

7 Click the State drop-down arrow, and then click to select the State where 
the incident is located.

8 In the Start Date box, type the incident Start Date, in the format 
MMDDYYYY.

9 To save your changes, click the Save button.

To clear your entries before saving the new incident, click the Clear button.
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The following diagram shows the Add tab on the Incident Add/Edit screen.

To manage all incidents as one

The Manage All Incidents as One check box allows you to display all 
resources together on a single list. While these resources must be reporting 
to the same ICP, they may not be from the same incident.

When working in this mode, you must select an incident to post each 
resource’s time.

• From any ITS screen, click to select the Manage All Incidents as One 
check box.

The following diagram shows the location of the Manage All Incidents as One 
check box.

Managing accounting codes
This section explains how to review, edit, and assign accounting codes to an 
incident and to resources.

To review an accounting code for an incident
1 On the Incident Data menu, click Incident Accounts.
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2 Click the Incident # drop-down arrow, and then click to select the 
Incident of your choice.

The following diagram shows the Manage Incident Accounts screen.

To edit an accounting code
1 On the Incident Data menu, click Incident Accounts.

2 Click the Incident # drop-down arrow, and then click to select the 
Incident of your choice.

3 On the Manage Incident Accounts screen, click the Edit button.

4 On the Edit Account dialog box, modify the following information as 
appropriate

- Accounting Code
- Agency Code.

5 To set this Accounting Code as the default, click to select the Set as 
Default Accounting Code for This Incident check box.

6 To save your changes, click the Save button.
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The following diagram shows the Edit Account dialog box on the Manage 
Incident Accounts screen.

To add multiple accounting codes to an incident
1 On the Incident Data menu, click Incident Accounts.

2 On the Manage Incident Accounts screen, click the Add button.

3 On the Add Account dialog box, add the following information as 
appropriate

- Accounting Code
- Agency Code.

4 To set this Accounting Code as the default, click to select the Set as 
Default Accounting Code for This Incident check box.

5 To save your changes, click the Save button.
September 9, 2004 11



Incident Time System User’s Guide Incident Time System User’s Guide
The following diagram shows the Add Account dialog box on the Manage 
Incident Accounts screen.

To identify the administrative office(s) for payment

Identify the administrative office during the initial startup for an incident.

1 On the Incident Data menu, click Admin Office for Payment.

2 Click the Add button.

3 On the Add Office Information dialog box, complete the following 
information

- Office Name
- Address 1
- Address 2
- City
- ST
- Zip.

4 When finished, click the Save button.
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The following diagram shows the Add Office Information dialog box on the 
Manage Administrative Offices For Payment screen.

Working with personnel information
This section explains how to edit and add personnel information. Topics in 
this section include:

• Editing and adding personnel data
• Posting personnel time.

Editing and adding personnel data
Remember these key points when working with personnel data for posting 
time and tracking payments:

• In the integrated environment, you will edit personnel data entered by 
Check-In (IRSS) personnel.You share data ownership between Resource 
Planning and Finance groups.

• In the stand-alone environment, you must enter all personnel data. You do 
not share data ownership.

• By default, all Social Security Numbers that originate from IRSS are 
“999-99-9999.” For AD employees, you must enter the exact SSN for that 
individual, or enter “999-99-9999” if the SSN is not currently available.

To edit personnel data - integrated environment
1 On the Personnel Add/Edit screen, click the Edit/Lookup tab.

2 Click the Select Personnel drop-down arrow, and then click to select the 
Person of your choice.
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3 For AD personnel, type the person’s Social Security Number in the 
Social Security Number box, in the format 123456789.

When completing the Social Security Number box, the cursor will 
automatically advance to the next field as you type.

4 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

5 Click the AD/Fed/Other drop-down arrow, and then click to select the 
the Employment Code of your choice

- AD - for casual Federal employees
- Fed - for Federal employees
- Other - for other types of employees, such as county and state.

6 To specify a contracted resource, click to select the Contracted Resource 
check box.

7 For AD personnel, complete the Payment Information tab as 
appropriate:

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

8 On the Personnel Mailing Address tab, complete the following 
information as appropriate:

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

9 To save your changes, click the Save button.
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The following diagram shows the Edit/Lookup tab on the Personnel Add/Edit 
screen.

To add personnel data - stand-alone environment
1 On the Personnel Add/Edit screen, click the Add tab.

2 In the Request Number box, type the Request Number for that person, 
in the format X1234.

Valid Request Numbers include: 
A - for Aircraft 
C - for Crews 
E - for Equipment 
I - for Initial Attack 
O - for Overhead 
S - for Supplies.

3 In the Last Name box and First Name box, type the First and Last 
Name of the person.

4 For AD personnel, type the person’s Social Security Number in the 
Social Security Number box, in the format 999999999.

For resources not requiring an SSN for payment, type 999999999.
When completing the Social Security Number box, the cursor will 
automatically advance to the next field as you type.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.
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6 Click the Kind/Position drop-down arrow, and then click to select the 
Kind/Position of your choice.

7 Click the Status drop-down arrow, and then click to select the current 
Status.

8 Click the AD/Fed/Other drop-down arrow, and then click to select the 
the Employment Code of your choice

- AD - for temporary Federal employees
- Fed - for full-time Federal employees
- Other - for other types of employees, such as seasonal and state.

9 To specify a contracted resource, click to select the Contracted Resource 
check box.

10 Click the Agency drop-down arrow, and then click to select the Agency 
of your choice.

11 In the Remarks box, type any appropriate Remarks.

12 On the Payment Information tab, complete the following information as 
appropriate:

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

13 Click the Personnel Mailing Address tab, and then complete the 
following information as appropriate:

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

14 To save your changes, click the Save button.
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The following diagram shows Add tab on the Personnel Add/Edit screen.

The following diagram shows the Personnel Mailing Address tab on the 
Personnel Add/Edit screen.
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Posting personnel time
This section explains how to post time for personnel. Remember these key 
points when posting personnel time:

• Posting time is performed the same, whether working in the stand-alone 
or integrated environments.

• You can edit the Stop and Start times, Special codes, and rates directly on 
the Personnel Post Detail.

• You can not edit the Date. To change the Date you must delete and then 
repost that entry.

• The Date automatically changes for posting that extends beyond midnight 
for any given shift.

• If you post overlapping hours, you must verify the hours before you can 
proceed.

To post personnel time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button.

2 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drop-down arrow, and then click to select the Person of your 
choice.

3 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

4 In the Date box, type the Date, in the format MMDDYYYY.

When completing the Date box, the cursor will automatically advance to 
the next date field as you type.
To enter the current Date, type = (equal sign). To enter yesterday’s Date. 
type - (minus sign). To enter a Future Date, type + (plus sign).

5 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

6 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

7 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

8 To commit the posting, click the Commit Posting button.

Clicking the Commit Posting button saves your data.
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The following diagram shows the Incident Post screen for posting personnel 
time.

To post time when managing all incidents as one
1 On the ITS toolbar, click to select the Manage All Incidents as One 

check box.

2 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drip-down arrow, and then click to select the Person of your 
choice.

3 Click the Account Code drop-down arrow, and then click to select the 
Incident/Acct Code combination of your choice.

Be sure to select the correct person, incident, and account code.

4 Complete the remaining information as appropriate

- Date
- Start Time
- Stop Time
- Special.

5 To commit the posting, click the Commit Posting button.
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The following diagram shows the Incident Post screen when managing all 
incidents as one. In this example, the Account Code drop-down arrow lists 
three different incidents.

To repost a day of time with different hours
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 In the Date box, type the Date in the format MMDDYYYY.

3 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

4 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

5 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

6 To commit the posting, click the Commit Posting button.

7 On the Overlapping Hours dialog box, click Yes or click Yes to All.
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The following diagram shows the Overlapping Hours dialog box.

To change the AD rate, Kind Code, and Special code - one-time 
change only
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the non-federal 
Person of your choice.

2 Locate the row containing the Class and Rate you want to change.

3 Click to select the Class box, and then type to replace the existing AD 
designation with the new AD designation.

For AD-5 rates, type the Rate on the ITS:AD-5 dialog box, in the format 
99.99, and then click OK.

4 To change the Kind Code, click the Kind Code drop-down arrow, and 
then click to select the Kind Code of your choice.

5 Locate the row containing the Special code you want to change.

6 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

7 To commit the posting, click the Commit Posting button.

The following diagram shows the ITS:AD-5 dialog box for entering an AD-5 
rate.
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To permanently change the AD rate and/or Kind Code for all 
future personnel postings - to change all subsequent postings
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person who has 
the AD rate you want to change.

2 On the Payment Information tab, click the Class drop-down arrow, click 
to select the AD Rate of your choice.

3 To change the Kind Code, click the Kind Code drop-down arrow, and 
then click to select the Kind Code of your choice.

4 When finished, makingclick the Save button.

To delete a row of time
1 On the Incident Post screen on the Personnel tab, click the Select 

Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 Click in the cell for the row you want to delete, and then click the Delete 
button.

To post return travel time

Posting end travel time sets the number of Hours to 0 (zero) and the Special 
code to TVL.

1 On the Incident Post screen on the Personnel tab, click the Select 
Personnel drop-down arrow, and then click to select the Person of your 
choice.

2 Click to select the Check here to Post Return Travel Day check box.

3 In the Date box, type the Date, in the format MMDDYYYY.

4 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

5 To commit the posting, click the Commit Posting button.

To view and/or print an OF-288 
1 On the Incident Post screen, click the Print OF288 button, or click  

OF-288 on the Reports menu.

2 On the OF-288 dialog box, perform one of the following

- to view the OF-288 by request number, click the Request Number 
drop-down arrow, and then click to select the Request Number of 
your choice.

- to view the OF-288 for a person, click the Person drop-down arrow, 
and then click to select the Person of your choice.
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3 To view the final OF-288 for a resource leaving the incident, click to 
select the Final Invoice check box.

4 To preview the OF-288, click the Preview Report button.

5 To print the OF-288, click the Print Report button.

If this is a partial payment and you want the resource’s social security number 
to print on the OF-288, you must click to select the Final Invoice check box.

The following diagram shows the OF-288, “Emergency Firefighter Time 
Report” dialog box.
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The following diagram shows a sample Emergency FireFighter Time Report 
OF-288 for an individual overhead resource, as it appears on your screen.

Working with crews and members/operators
This section explains how to view, add, edit, and print crews and crew 
members/operators, and how to demobilize (demob) a crew and/or crew 
members/operators. Topics in this section include:

• Understanding crews
• Creating and editing crews
• Posting time for crews and crew members/operators
• Reviewing an OF-288 for crews.

Understanding crews
Remember these key points when working with crews and members/
operators:

• In ITS, a crew is more than one resource sharing the same request 
number. A crew may be a hand crew, engine crew members, or a contract 
pickup with an AD driver.

• There are two levels of crew information:
- At the crew level, you can add and/or edit information about the crew.
- At the member/operater level, you can add and/or edit information 
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about the individual crew members/operators on a crew.
• You can build a crew by attaching or rostering members to a resource

- In the integrated environment, IRSS populates ITS with shared data. 
If members are being rostered in IRSS, then you will primarily need 
to edit members.  If members are not being rostered in IRSS, then you 
must add members to a crew or to a piece of equipment.

- In the stand-alone environment, you will manage all data, including 
adding and then rostering members/operators to a crew.

To view and print a crew manifest
1 Click the Crews/Operators button.

2 On the Crew/Operator Roster screen, perform one of the following

- click the Request # drop-down arrow, and then click to select the 
Request # of your choice

- click the Crew Name/Equipment UniqueID drop-down arrow, and 
then click to select the Crew Name/Equipment of your choice.

3 To view the crew manifest, click the Print Crew/Operator Manifest 
button.

The crew manifest is a good place to view the initial crew data entered 
from IRSS.

4 To print the crew manifest, click the Print icon on the Crew Roster 
Report dialog box, and then click OK on the Print dialog box.

The following diagram shows the Crew/Operator Roster screen.
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The following diagram shows a sample crew manifest on the Crew Roster 
Report dialog box.

The following diagram shows the Print dialog box that displays when printing 
a crew manifest. 

Creating and editing crews
This section explains how to add and edit crew data in the integrated and 
stand-alone environments. There are two levels of crew information:

• Crew level. Add and/or edit information about the crew.
• Member/operator level. Add and/or edit information about individual 

crew members/operators on a crew.

To edit crew information
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Crew/Equipment tab.
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5 On the Crew/Equipment tab, modify the following information as 
appropriate

- Request Number
- Crew Name/Equipment UniqueID
- Kind/Position
- Agency
- Status
- Account Code
- Contact Crew.

6 To save your changes, click the Save button.

The following diagram shows the Crew/Equipment tab on the Crew & 
Operators Add / Edit screen.

To edit crew members on a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Member/Operator tab.

5 Click the Select Personnel drop-down arrow, and then click to select the 
Crew member/Operator of your choice.

6 Complete the remaining personnel data as appropriate, and then click the 
Save button.
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The following diagram shows the Member/Operator tab on the Crew & 
Operators Add / Edit screen. The arrow points to the Members to fed button.

To set all crew members/operators with unassigned employment 
types to “fed”
1 On the Crew & Operators Add/Edit screen, click the Crew/Member/

Edit tab.

2 Click the Select Crew/Equipment drop-down arrow, click to select the 
Crew of your choice, and then click the Members to fed button.

To add crew members to an existing crew

In some cases, the crew leader will already be listed on the crew. You can add 
the remaining crew members, but can only edit the crew leader.

1 On the Crew/Operator Roster screen, click the Add/Edit Crew/
Operators button.

2 On the Crew & Operators Add/Edit screen, click the Add tab, and then 
click the Member/Operator tab.

3 Click the Crew/Equipment to Add To drop-down arrow, and then click 
to select the Crew or Equipment of your choice.

4 Complete the following information as appropriate

- First Name
- Last Name
- Social Security Number
- Account Code
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- Kind/Position
- Status
- AD/Fed/Other
- Agency
- Remarks.

5 On the Payment Information tab, complete the following information as 
appropriate

- Initial Employment
- Return Travel
- Point of Hire
- Area
- Class
- Current Rate.

6 Click the Personnel Mailing Address tab, and then complete the 
following information as appropriate

- Address 1
- Address2
- City
- ST
- Zip
- Phone
- Fax.

7 Click the Save button.

The following diagram shows the Member/Operator tab on the Add tab on the 
Crew & Operators Add/Edit screen.
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To edit the leader of a crew to add crew members
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 On the Edit/Lookup tab, click the Select Crew/Equipment drop-down 
arrow, and then click to select the Crew that contains the .

3 Click the Member/Operator tab.///

To create a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 On the Crew & Operators Add/Edit screen, click the Add tab.

3 On the Crew/Equipment tab, complete the following information as 
appropriate

- Request Number
- Crew Name/Equipment UniqueID
- Kind/Position
- Agency
- Status
- Account Code
- Contract Crew.

4 Click the Save button.

5 Add crew members as appropriate.

For more information about adding crew members, see the previous task, 
“To add crew members to an existing crew.”

To demob a crew
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Crew/Equipment tab.

5 Click the Status drop-down arrow, click to select Demobed, and then 
click the Save button.
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The following diagram shows the Edit/Lookup tab on the Crew & Operators 
Add / Edit screen. The arrow points to the “Demobed” Status for the crew.

To demob a crew member/operator
1 On the Crew/Operator Roster screen, click the Add/Edit Crew/

Operators button.

2 Click the Edit/Lookup tab.

3 Click the Select Crew/Equipment drop-down arrow, and then click to 
select the Crew or Equipment of your choice.

4 Click the Member/Operator tab.

5 Click the Select Personnel drop-down arrow, and then click to select the 
Crew member/Operator of your choice.

6 Click the Status drop-down arrow, click to select Demobed, and then 
click the Save button.
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The following diagram shows the Edit/Lookup tab on the Crew & Operators 
Add / Edit screen. The arrow points to the “Demobed” Status for the crew 
member.

Posting time for crews and crew members/operators
This section explains how to post time for crews and crew members/
operators. Remember these key points when posting time for crews and crew 
members/operators:

• Posting time is performed the same, whether working in the stand-alone 
or integrated environments.

• Do not edit the Stop and Start times, Special codes, and rates on the Crew 
Member/Operator Post Detail.

• You cannot edit the Date. To change the Date you must delete and then 
repost that entry.

• The Date automatically changes for posting that extends beyond midnight 
for any given shift.

• If you post overlapping hours, you must verify the hours before you can 
proceed.

• Post all time to a crew member before he/she is demobed. If you use the 
Select All button and select a demobed crew member, that time will not 
be posted!

• explain grid functionality, editing, deleting, copy and past, reviewing.///
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To post time crew time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button.

2 On the Incident Post screen, click the Crews & Operators tab.

3 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Equipment Name of your choice.

4 Under Crew Members, click to select the Crew Member(s) of your 
choice.

To select more than one Crew Member, press and hold CTRL, and then 
click to select every Crew Member of your choice.

5 In the Date box, type the Date, in the format MMDDYYYY.

When completing the Date box, the cursor will automatically advance to 
the next date field as you type.
To enter the current Date, type = (equal sign). To enter yesterday’s Date. 
type - (minus sign).

6 Click the Start Time drop-down arrow, and then click to select the Start 
Time of your choice.

7 Click the Stop Time drop-down arrow, and then click to select the Stop 
Time of your choice.

8 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

9 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

10 To commit the posting, click the Commit Posting button.

Clicking the Commit Posting button saves your data.

11 On the Incident Time System: Post Results dialog box, click OK.
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The following diagram shows the Crews & Operators tab on the Incident Post 
Posting Crews screen.

To select all crew members/operators
• On the Incident Post screen, click the Crews & Operators tab, and then 

click the Select All button.

To cancel all selected crew members/operators
• On the Incident Post screen, click the Crews & Operators tab, and then 

click the Select None button.

To cancel all selected crew members/operators and select all 
others

The Invert Selection button makes posting crew leader and crew member 
time easier. First, post the Crew Leader’s time, click the Invert Selection 
button, and then post the crew members’ time.

• On the Incident Post screen, click the Crews & Operators tab, and then 
click the Invert Selection button.

To repost a day of time
1 On the Incident Post screen, click the Crews & Operators tab.
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2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

Be sure to select the correct crew member.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Locate the day and time you want to repost, and then type the same Date 
as the existing Date.

5 Complete the Start Time, and Stop Time boxes with the new 
information.

6 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

7 Click the Special drop-down arrow, and then click to select the Special 
code of your choice.

8 To commit the posting, click the Commit Posting button.

9 On the Overlapping Hours dialog box, click Yes to overwrite the 
previous post with the current one.

10 On the Incident Time System: Post Results dialog box, click OK.

To delete a row of posted time

The Delete button is located on the ITS toolbar.

1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

Be sure to select the correct crew member.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the day and 
time you want to delete.

5 Click the Delete button.

6 On the ITS: Delete Posting for Crew Member(s) dialog box, click Yes.

To copy and paste posted time
1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the day and 
time you want to copy.
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5 Right-click on that row, and then point to Copy Selected Postings.

6 Under Crew Members, click to select the destination Crew Member for 
the copied row of time.

7 Right-click the destination Crew Member and then point to Paste 
Copied Posting to Selected Mbrs.

8 On the Incident Time System: Post Results dialog box, click OK.

The following diagram shows the Incident Post - Posting Crews screen. The 
arrow points to the Paste Copied Posting the Selected Mbrs option highlighted 
on the Incident Post Posting Crews screen.

To post return travel time
1 On the Incident Post screen, click the Crews & Operators tab.

2 Click the Crew Name/Equip UniqueID drop-down arrow, and then click 
to select the Crew Name or Unique ID of your choice.

3 Under Crew Members, click to select the Crew Member of your choice.

4 Under Crew Member/Operator Post Detail, click to select the row of 
time of your choice, and then click to select the Check here to Post 
Return Travel Day check box.

5 Complete the Date, Start Time, and Stop Time boxes.

6 To commit the posting, click the Commit Posting button.

7 On the Overlapping Hours dialog box, click Yes to overwrite the 
previous post with the current one.

8 On the Incident Time System: Post Results dialog box, click OK.
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Reviewing an OF-288 for crews
The OF-288 lists all incidents and all accounting codes for the selected 
request number, crew name, person, or all personnel.

To review an OF-288
1 On the Reports menu, click OF-288.

2 On the OF-288 dialog box, click the Crew Name drop-down arrow, and 
then click to select the Crew Name or Unique ID of your choice.

3 To view the final OF-288 for the crew leaving the incident, click to select 
the Final check box.

4 To preview the OF-288, click the Preview Report button.

5 To print the OF-288, click the Print Report button.

The following diagram shows a sample OF-288 for crews.
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Working with contractor and agreement data
This section explains how to add and edit contractor and agreement data. In 
ITS, you must add and attach contractor and agreement data to a resource to 
process payment documents. Remember these key points when working with 
contractor and agreement data:

• You only need to enter contractor and agreement data once.
• For multiple resources sharing the same contractor and agreement, pick 

the specific contractor and agreement and then attach it to the resource.
• You can assign up to six rates to each resource.
• Units of measure include Daily, Each, Hourly, and Mileage.

Topics in this section include:

• Understanding the contractor, agreement, and resource relationship
• Understanding rate types and units of measure
• Managing contractor and agreement data.

Understanding the contractor, agreement, and resource relationship
In ITS, a contract consist of three parts:

• Contractor. A business entity that has available resources.
• Agreement. One or more OF-294 - Emergency Equipment Rental 

Agreement (EERA) attached to the contractor. A contractor may have 
multiple agreements.

• Specifications. Conditions the resource must meet to fulfill the 
agreement.

The following diagram shows the relationship between the contractor, 
agreement, specifications, and resource.

Understanding rate types and units of measure
Together, rate types and units of measure allow ITS to calculate the cost of the 
contracted resource. The following list briefly explains rate types and units of 
measure:

• Primary rate. All contracted resources must have a primary rate 
designation.

• Special rate. A contracted resource may or may not have one to five 
special rate designations.
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• Units of measure. Units of measure include Daily, Each, Hourly, and 
Mileage. 

Be sure to match the correct rate with the correct unit of measure! For 
example, a contracted piece of equipment may have a primary, daily rate of 
$52.00 and a special, mileage rate of $0.32.

Managing contractor and agreement data
This section explains how to review and create contractors and agreements, 
and how to attach an agreement to the contractor.

To review the list of existing contractors

Determine if the contractor already exists before creating a new one.

1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Type, click 
to select one of the following resource Types:

- Contract Equipment
- Contract Crews
- Other Contracts.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor of your choice.

If the contractor does not appear on the drop-down list, then create one! 

The following diagram shows the Contracted Resource Add/Edit screen for 
contracted equipment.
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To create a contractor
1 On the Contracted Resource Add/Edit screen, complete the following 

information as appropriate

- Name
- EIN/SSN
- Address
- City
- ST
- Zip
- Phone.

2 Click the Save button.

Next, determine if an agreement already exists and is attached to the 
contractor. If not, create an agreement and attach it to the contractor. If 
so, edit the resource specifications and then link them to the contractor/
agreement.

The following diagram shows the Add tab on the Contracted Resource Add/
Edit screen.

To create an agreement and attach it to the contractor
1 On the Agreement tab, click the Add tab.

2 In the Agreement Number box, type the Agreement Number.

3 In the Begin Date box, type the beginning date of the agreement, in the 
format MMDDYYYY.
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4 In the Expiration Date box, type the expiration date of the agreement, in 
the format MMDDYYYY.

5 In the Point of Hire box, type the location at the time of hire.

6 Click the Administrative Office for Payment drop-down arrow, and 
then click to select the Administrative Office of your choice.

7 To attach the agreement to the contractor, click the Agreement Number 
drop-down arrow, and then click to select the Agreement Number of 
your choice.

8 Click the Save button.

The following diagram shows an example of a new agreement on the 
Contracted Resource Add/Edit screen.
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The following diagram shows the new agreement attached to the contractor.

To edit resource specifications and link it to a contractor and 
agreement

In the integrated environment, the resource is already added to the incident 
database from IRSS. In ITS, you must edit the resource specifications and 
create a new name for it, then link the resource together with the contractor 
and agreement.

1 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice for the 
Contractor/Agreement of your choice.

3 On the Resource tab on the Edit tab, type a new, unique name for the 
resource in the Unique ID box.

4 Complete the Make, Model, and Remarks boxes as appropriate.

5 Click to select the Gov’t Operator and Gov’t Supplies check boxes, as 
appropriate.

6 Complete the Hired Date and Time boxes and the Release Date and 
Time boxes, as appropriate.

7 Click to select the Withdrawn check box, as appropriate.

8 Click the Rate Type drop-down arrow, and then click to select the Rate 
Type of your choice.
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9 Click the Rate box, and then type the appropriate Rate for that Rate Type 
and Unit of Measure.

10 Press TAB twice to advance the cursor to the next Rate Type box.

11 Verify that the correct Request Number, Contractor Name, and 
Agreement Number display on the upper portion of the Contracted 
Resource Add/Edit screen.

12 Click the Save button.

13 On the Warning - Check for Correct Agreement/Contractor dialog 
box, click Yes.

The following diagram shows the Contracted Resource Add/Edit screen for 
linking a resource to the contractor and agreement.

To add an operator to a resource

If a leader was added by IRSS into the incident database, you will only need 
to edit the operator information.

1 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice for the 
Contractor/Agreement of your choice.

3 On the Resource tab on the Edit tab, click the Add Operator(s) button.
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4 On the Crews & Operators Add/Edit screen, on the Add tab on the 
Member/Operator tab, add or edit the following information as 
appropriate

- First Name
- Last Name
- Social Security number
- Account Code
- Kind/Position
- Status
- AD/Fed/Other
- Agency
- Remarks.

5 Complete the Payment Information tab as appropriate.

6 Click and then complete the Personnel Mailing Address tab as 
appropriate.

7 Click the Save button.

Add any additional contracted resources using information listed on the 
EERAs.

The following diagram shows the Member/Operator tab on the Crews & 
Operators Add/Edit screen for adding an operator to a resource.
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Posting time for contracted resources
This section explains how to post time for contracted resources. The SF-297, 
“Emergency Equipment Shift Ticket,” lists the information you need to post 
contracted resources time in ITS. 

Remember these key points when posting time for contract equipment:

• Daily rate. You can post for one date or for a range of dates.
• Hourly rate. To ensure a guarantee is posted for equipment not currently 

being used on any given day but still under hire, enter a minimum of 15 
minutes of work time and 1 mile of mileage.

• Guarantee. If applicable, the guarantee amount is shown only on the OF-
286, but will not display on the Incident Post - Posting Equipment screen.

The following table outlines how to post units of measure for contracted 
resources in ITS.

The guarantee amount is shown only on the OF-286 but does not display on 
the Incident Post-Posting Equipment screen.

To post contracted resource time

Remember, you can click to select the Use Enter Key as Tab for Posting 
check box for faster, 10-key data entry!

1 Click the Post Time button, and then click the Contract Equipment, 
Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

To post Do this
Daily rate Complete Start Date and End Date.
Hourly rate Complete Date and Start and Stop 

times.
Mileage Complete Date and Miles.
Each Complete Date and Each.
equipment not being used on any 
given day but still under hire

Enter a minimum of 15 minutes of 
work time and 1 Mile.
September 9, 2004 45



Incident Time System User’s Guide Incident Time System User’s Guide
6 Under Post Options, click to select the Rate Type of your choice.

7 If one-half rate applies, click to select the 1/2 Rate check box.

8 Post the required information as appropriate for that Rate Type and Unit 
of Measure.

Remember to review the previous table for posting rates and units of 
measure.

9 To commit the posting, click the Commit Posting button.

The following diagram shows the Incident Post screen for posting contract 
equipment time.

To repost a day of time by overwriting the existing entry

When reposting contracted resource time, you can either add to the original 
posting or overwrite the existing entry.

1 Click the Post Time button, and then click the Contract Equipment, 
Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.
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5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

6 Under Post Options, click to select the Rate Type of your choice.

7 Complete the appropriate Start Date and End Date boxes.

8 To commit the posting, click the Commit Posting button.

9 On the Already Posted dialog box, click the Overwrite button.

The following diagram shows the Already Posted dialog box.

To delete a row of posted time
1 Click the cursor in the Acct column for the row of time you want to 

delete.

2 On the ITS toobar, click the Delete button.

To review an OF-286 for contracted resources

The OF-286 is an invoice for a contracted resource on an incident, and lists 
the rates and dates the contracted resource was used.

1 On the Reports menu, click OF-286 w/ Deductions.

2 On the OF-286 dialog box, perform one of the following

- click the Contractor drop-down arrow, and then click to select the 
Contractor Name of your choice

- click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

- click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.

3 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

4 To preview the report, click the Preview Report button.
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5 To print the report, click the Print Report button.

The following diagram shows a sample OF-286 for a contracted resource.

Working with commissary debits and additions
Working with commissary debits and additions is straightforward. Once you 
select a resource, enter the date, description, and amount. Then review the 
details of the transactions on the OF-288 and OF-286.

To preview a Commissary Authorization form

You can view and/or print a Commissary Authorization form by request 
number, crew name, or person.

1 On the Reports menu, click Commissary Authorization.

2 On the Commissary Authorization dialog box, perform one of the 
following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name of your choice.
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- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Commissary Authorization dialog box.

The following diagram shows a sample Emergency FireFighter Commissary 
Authorization as it appears on your screen.
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To post deductions to a personnel resource

 Remember to press TAB to advance the cursor to the next box. Information 
you enter is auto-saved as soon as you enter a new blank line. 

1 Click the Commissary/Debits & Additions button.

2 On the Personnel tab, click the Person drop-down arrow, and then click 
to select the Person of your choice.

3 In the Activity Date column, type the Date in the format MMDDYYYY.

4 In the Commodity column, type the name of the Commodity.

Commodities include items such as socks, boots, and toiletries.

5 In the Purchase Amount column, type the Purchase Amount for those 
commodities, in the format 99.99.

6 To save the charges and advance to the next new line, press TAB.

The following diagram shows a sample Personnel Debits screen.

To post contractor deductions to a resource
1 Click the Commissary/Debits & Additions button, and then click the 

Contractor tab.

2 Under Select Type, click to select one of the following

- Contract Equipment
- Contract Crews
- Other Contracts.
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3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Click the Contract Resource drop-down arrow, and then click to select 
the Contract Resource of your choice.

5 In the Activity Date column, type the Date in the format MMDDYYYY.

6 In the Commodity column, type the name of the Commodity.

7 In the Purchase Amount column, type the Purchase Amount for those 
commodities, in the format 99.99.

8 To save the charges and advance to the next new line, press TAB.

The following diagram shows the Contractor Debits screen.

To post a contractor addition
1 Click the Commissary/Debits & Additions button, and then click the 

Contractor tab.

2 On the Contractor tab under Select Type, click to select the Type of your 
choice.

3 Click to select the Contractor Name and Contract Resource of your 
choice.

4 In the Activity Date column, type the Date in the format MMDDYYYY.

5 In the Commodity column, type the Commodity.
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6 In the Purchase Amount column, type -Purchase Amount for those 
commodities.

Typing “-” (minus sign) in front of the Purchase Amount allows you to post 
an addition to the OF-286 report.

7 To save the charges and advance to the next new line, press TAB.

Notice that the negative symbol is replaced by parentheses in the 
purchase amount column.

To review an OF-288 for resources with posted deductions and 
additions

The deductions page displays on a separate window, behind the OF-288 and 
the OF-286.

1 On the Reports menu, click OF-288.

2 On the OF-288 dialog box, click to select one of the following

- Request Number
- Crew Name
- Person.

3 To view the final OF-288 for the crew leaving the incident, click to select 
the Final check box.

4 To preview the OF-288, click the Preview Report button.

5 To review the deductions page of the OF-288, click the Minimize button 
on the OF-288 window.

6 To print the OF-288, click the Print Report button.

The following diagram shows a sample Commissary Record as it appears on 
your screen.

To review an OF-286 for resources with posted deductions and 
additions
1 On the Reports menu, click OF-286 w/ Deductions.
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2 On the OF-286 dialog box, click the Contractor drop-down arrow, and 
then click to select the Contractor Name of your choice.

3 Click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

4 Click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.

5 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

6 To preview the OF-288, click the Preview Report button.

7 To review the deductions page of the OF-286, click the Minimize button 
on the OF-286 window.

8 To print the OF-286, click the Print Report button.

The following diagram shows a sample Emergency Equipment Deductions 
and Additions report as it appears on your screen.

Working with reports
This section explains how to prepare, view, and print reports available in ITS. 
The Reports menu lists management, equipment, commissary authorization, 
crew roster, and pay document reports.

To review and print a Commissary Authorization form

You can view and/or print a Commissary Authorization form by request 
number, crew name, or person.

1 On the Reports menu, click Commissary Authorization.
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2 On the Commissary Authorization dialog box, perform one of the 
following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name of your choice.

- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

To view and print a crew roster

This report lists the names of individual crew members for a crew.

1 On the Reports menu, click Crew Roster.

2 On the Crew Roster dialog box, perform one of the following

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Crew Name drop-down arrow, and then click to select the 
Crew Name/Equipment of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Crew Roster dialog box.
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The following diagram shows a sample Crew Roster as it appears on your 
screen.

To prepare a Shifts in Excess of Standard Hours report

This report lists shifts that exceed standards and allows you to identify initial 
attack shifts and other shift issues that need documentation.

1 On the Reports menu, click Shifts in Excess of Standard Hrs.

2 On the Shifts in Excess of Standard Hours Report dialog box, perform 
one or more of the following as appropriate

- click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice

- click the Person drop-down arrow, and then click to select the Person 
of your choice.

3 Click the Start Date drop-down arrow, and then click to select the Start 
Date of your choice.

4 Click the End Date drop-down arrow, and then click to select the End 
Date of your choice.

5 In the Excess Hours box, type the minimum total number of Excess 
Hours to be reported.

6 Under Sort by, click to select one of the following

- Request #
- Person
- Total.

7 Click the Run Report button.

8 To print the report, click the Print Report icon.
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The following diagram shows the Shifts in Excess of Standard Hours Report 
dialog box.

The following diagram shows a sample Shifts in Excess of Standard Hours 
report, as it appears on your screen.
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To view the Equipment Management Report
1 On the Reports menu, click Equipment Management.

2 To print the report, click the Print Report icon.

The following diagram shows a sample Equipment Management Report as it 
appears on your screen. 

To view the Contractor Debits Report
1 On the Reports menu, click Contractor Debits.

2 On the Contractor Debits dialog box, click the Contractor drop-down 
arrow, and then click to select the Contractor of your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.
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The following diagram shows a sample Contractor Debits report as it appears 
on your screen.

To view the Payment Summary of Equipment report
1 On the Reports menu, click Payment Summary of Equipment.

2 On the Payment Summary of Equipment Usage Report dialog box, 
click the drop-down arrow, and then click to select the Contractor of 
your choice.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Payment Summary of Equipment Usage 
Report dialog box.
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The following diagram shows a sample Payment Summary of Equipment 
report as it appears on your screen.

To view the Summarization of Hours Worked report
1 On the Reports menu, click Summary of Hours Worked.

2 On the Summarization of Hours Report dialog box, perform one of the 
following

- to obtain information for an individual, click the Select Person drop-
down arrow, and then click to select the Person of your choice.

- to obtain information for all personnel, click Select All Personnel.

3 Click the Run Report button.

4 To print the report, click the Print Report icon.

The following diagram shows the Summarization of Hours Report dialog box.
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The following diagram show a sample Summarization of Hours Worked on 
Incident report as it appears on your screen.

Performing searches for personnel or equipment
This section explains how to perform personnel and equipment searches and 
how to sort data elements by column heading.

Personnel and equipment searches are performed in the same manner. By 
performing a search, you can:

• query on one or more data elements
• find a resource and determine whether a name is connected to the wrong 

resource.

By using the sort feature in ITS, you can organize the data elements to suit 
your reporting needs.

To perform a personnel or equipment search
1 Click the Personnel Search button or the Equipment Search button.

2 Locate the column heading that identifies the data element for your 
search.
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3 To narrow your search, click in the blank cell above the column heading 
of your choice, type the first several characters of the target data element, 
and then press TAB.

The following diagram shows the Personnel Search screen.
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The following diagram shows the Equipment Search screen.

To sort data elements by column heading
1 Click the Personnel Search button or the Equipment Search button.

2 Locate the column heading that identifies the data element you want to 
sort, and then click that column heading title.

Putting it all together
This section explains some advanced topics you can perform in ITS, including 
how to:

• manage contractor and agreement data from IRSS input
• work with the appropriate Unit of Measure (UOM) and coordinating with 

cost
• handle complicated contracts
• work with auditing functions for personnel and crew time, equipment 

time, and commissary time
• close out pay documents
• manage multiple incidents.
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Managing contractor and agreement data from IRSS input
This section explains how to work with complex contracts for resources such 
as contract crews and engines, portable toilets, and resources with multiple 
rates based on duration.

Review contracts and shift tickets to add contractor data and to post time to 
contracted resources.

The following diagram outlines the basic process for working with contractor 
and agreement data.

To determine if the contractor already exists in the I-Suite 
database
1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Type, click 
to select the Contract Resource of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor of your choice.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to the list of existing contractors in the I-Suite database.

To add a new contractor

Refer to the contract to add new contractor data. For more information about 
adding a contractor, see the previous section, “Working with contractor and 
agreement data.”

1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen, click the Add tab.

3 Complete the following information as appropriate

- Name
- EIN/SSN
- Address
- City
- ST
- Zip
- Phone.

4 Click the Save button.

For an example of the Contracted Resource Add/Edit screen, see the 
previous section, “Working with contractor and agreement data.”
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To create an agreement and attach it to a contractor

Before creating the agreement, be sure the Contractor Name is displaying on 
the Contracted Resource Add./Edit screen.

1 On the Contracted Resource Add/Edit screen, click the Contractor 
Name drop-down arrow, and then click to select the Contractor Name of 
your choice.

2 Click the Agreement tab, and then click the Add tab.

3 Complete the following information

- Agreement Number
- Begin Date
- Expiration Date
- Point of Hire
- Administrative Office for Payment.

4 To attach the agreement to the contractor, click the Agreement Number 
drop-down arrow, and then click to select the Agreement Number of 
your choice.

5 Click the Save button.

For an example of the Contracted Resource Add/Edit screen, see the 
previous section, “Working with contractor and agreement data.”
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To add resources and rates and link them to the contractor and 
agreement
1 On the Contracted Resource Add/Edit screen under Select Resource 

By, click Name or Request Number.

2 Click the Unique Name or Request Number drop-down arrow, and then 
click to select the Name or Request Number of your choice.

3 Complete the Contractor Name and Agreement Number boxes for the 
Contractor/Agreement of your choice.

4 On the Resource tab on the Edit tab, complete the following information

- in the Unique ID box, create a unique name for the resource
- complete the Make, Model, and Remarks boxes, as appropriate
- click to select the Gov’t Operator and Gov’t Supplies check boxes, 

as appropriate
- complete the Hired Date and Time boxes and the Released Date and 

Time boxes, as appropriate
- click to select the Withdrawn check box, as appropriate
- click the Rate Type drop-down arrow, and then click to select the 

Rate Type of your choice
- click the UOM drop-down arrow, and then click to select the Unit of 

Measure of your choice.
- click in the Rate box, and then type the appropriate Rate for that 

Rate Type and Unit of Measure.
- press TAB twice to advance the cursor to the next Rate Type box.

Remember to add all primary rates, and use special rates for mileage.
Be sure to press TAB to advance the cursor to the next blank row!

5 Verify that the correct Request Number, Contractor Name, and 
Agreement Number display on the upper portion of the Contracted 
Resource Add/Edit screen.

6 Click the Save button.

7 On the Warning - Check for Agreement/Contractor dialog box, click 
Yes.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to the Primary and Special Rate Types. 

The following diagram shows the Warning - Check for Agreement/Contractor 
dialog box.

Understanding rate types and Units of Measure 
Remember these key points when working with rate types and Units of 
Measure (UOM):

• All contracted resources must have a primary rate designation.
• A contracted resource may or may not have one to five special rate 

designations.
• Units of Measure include Daily, Each, Hourly, and Mileage.
• Be sure to match the correct rate type with the correct UOM.
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Posting time for contracted resources
This section explains how to post time for contracted resources using the 
appropriate primary and secondary rates, and how to print the OF-286.

To post time for contracted resources
1 Click the Post Time button, and then click the Contract Equipment, 

Crews and Other tab.

2 Under Select Type, select the equipment type of your choice.

3 Click the Contractor Name drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Perform one of the following

- Click the Equipment Unique ID drop-down arrow, and then click to 
select the Equipment of your choice.

- Click the Request Number drop-down arrow, and then click to select 
the Request Number of your choice.

5 Click the Account Code drop-down arrow, and then click to select the 
Account Code of your choice.

6 Under Post Options, click to select the Rate Type of your choice.

7 If one-half rate applies, click to select the 1/2 Rate check box.

8 Post the required information as appropriate for that Rate Type and Unit 
of Measure.

9 To commit the posting, click the Commit Posting button.

Once you have correctly posted the time for the resources, you can print 
the OF-286.

To print the OF-286

You can also print the OF-286 by clicking the Print OF-286 button on the 
Incident Post-Posting Equipment screen.

Once you create an original invoice, you cannot edit it.

1 On the Reports menu, click OF-286 w/ Deductions.

2 On the OF-286 dialog box under Select Type, click to select the 
equipment type of your choice.

3 Click the Contractor drop-down arrow, and then click to select the 
Contractor Name of your choice.

4 Click the Agreement drop-down arrow, and then click to select the 
Agreement of your choice.

5 Click the Equipment drop-down arrow, and then click to select the 
Equipment of your choice.
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6 Click the Last Date Included on Invoice drop-down arrow, and then 
click to select the Last Date for the partial payment.

7 Under Report Options, click to select one of the following

- OF-286 with Itemized Deductions
- OF-286 Only
- Itemized Deductions Only.

8 To preview and then print the report, click the Preview/Print Report 
button, and then click the Print Report icon.

Deleting a duplicate contractor
You may find that a contractor was entered in ITS twice. This duplicate 
resource may or may not have attached resources. 

You cannot delete a contractor with attached resources and/or an agreement.

The following diagram outlines the basic process for deleting a duplicate 
contractor.

To locate duplicate contractors
1 Click the Contracts button.

2 Click the Contractor Name drop-down arrow, and then locate the 
duplicate Contractor Names.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
arrow points to two duplicate contractors.

To rename duplicate contractors
1 On the Contracted Resource Add/Edit screen, on the Contractor tab, 

click the Edit tab.

2 Click the Contractor Name drop-down arrow, and then click to select the 
first duplicate Contractor Name you want to rename.

3 In the Name box, edit the Contractor Name, and then click the Save 
button.

For example, insert the number “1” to the end of the first duplicate 
contractor name.

4 On the Edit tab, click the Contractor Name drop-down arrow, and then 
click to select the second duplicate Contractor Name.

5 In the Name box, edit the Contractor Name, and then click the Save 
button.

For example, insert the number “2” to the end of the second duplicate 
contractor name.

To determine if the duplicate contrator has attached resources
1 Click the Equipment Search button.
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2 To sort data by Contractor Name, click the Contractor Name column 
heading.

3 Scroll to the duplicate Contractor Name(s).

If the Contractor Name is listed on the Equipment Search screen, it has 
attached resources. If one of the duplicate contractors does not appear 
on the Equipment Search screen, then it does not have attached 
resources.

The following diagram shows an example of the Equipment Search screen. 
The arrow points to the contractor, “Quality Motors, Inc” 

Quality Motors and Quality Motors, Inc are duplicate contractors. Since both 
contractors show up on the Equipment Search screen, they both have 
attached resources.

To move attached resources from one contractor to another
1 Click the Contracts button.

2 On the Contracted Resource Add/Edit screen under Select Resource 
By, click Name or Request Number, and then click to select the Name or 
Request Number to be moved.

3 Click to select the target Contractor Name and Agreement Number for 
the resource to be moved, and then click the Save button.

4 Move all remaining resources to the target Contractor Name/
Agreement Number.
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The following diagram shows the Contracted Resource Add/Edit screen. The 
resource, “E-89” is currently attached to QUALITY MOTORS2.

The following diagram shows the same resource, “E-89” moved to 
QUALITY MOTORS1.
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To delete a duplicate contractor with no attached resources

You must first delete the agreement before you can delete the contractor.

1 Click the Contracts button.

2 Click the Agreement Number drop-down arrow, click to select the 
appropriate Agreement Number, and then click the Delete button.

3 Click the Contractor Name drop-down arrow, click to select the 
Contractor Name you want to delete, and then click the Delete button.

4 To verify that you deleted the duplicate contractor, click the Refresh 
button.

The following diagram shows the agreement to be deleted from QUALITY 
MOTORS2.
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The following diagram shows the agreement deleted from QUALITY 
MOTORS2.

Working with partial payments
This section explains how to post a partial payment for a firefighter or to a 
contractor. 

Be sure to notify cost personnel about the partial payment!

To post a partial payment for a firefighter

Contact the responsible hiring agency for processing procedures if you need 
to post a partial payment for an OF-288.

To post a partial payment to a contractor

After printing the Original invoice, you can send it to the payment center for 
payment.

1 On the Reports menu, click OF-286.

2 On the OF-286 dialog box, complete the Contractor, Agreement, and 
Equipment boxes.

3 Click the Last Date Included on Invoice drop-down arrow, and then 
click to select the Last Date for the partial payment.
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4 Under Print Options, click to select Preview/Print ORIGINAL 
Invoice, and then click the Preview/Print Invoice button.

Once you create an original invoice, you cannot edit it.

5 Click the Print Report icon, and then click the OK and Yes buttons on 
the IReports dialog boxes.

To delete a previous invoice for payment to a contractor

Do not recreate an invoice if one has already been sent to the payment 
center. Use this option only if the previous invoice has not been sent to the 
payment center.

If creating the final invoice, set the release date and time, so that the 
information will be carried over to the resource edit screen for equipment.

1 On the Reports menu, click OF-286.

2 On the OF-286 dialog box, complete the Contractor, Agreement, and 
Equipment boxes.

3 Click the Delete Last Invoice For Selected Resource button.

4 On the Warning dialog box, click Yes.

The following diagram shows the OF-286 dialog box.
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The following diagram shows the Warning dialog box.
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